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Introduction
Label Editor Screen
The screen of this software consists of the following six areas.

[1]
[2]

[6]

[3]

[5]

[4]

1.

Menu bar
In addition to menus for editing and saving label files, there are menus for changing Label Editor preference settings
such as display settings.

2.

Tool bar
Shortcuts to access the menus that are commonly used.

3.

Tool box
Tools to add an object such as text, image, symbol, and barcode.
U “Inserting Objects in a Label” on page 7

4.

Data creation window
You can enter and edit contents of labels to be inserted into the Layout editing window. If this window is hidden, click
at the lower right of the screen.
U “How to Use the Data Creation Window” on page 12

5.

Layout editing window
By default, a label area is shown in gray, and a print area is shown in white. Insert a text or other object in the print
area to create a label.
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6.

Tape settings area
Menus for tape-related settings such as tape width and label length.
U “Setting Label Length” on page 11
U “Creating a Large Label by Printing One Image on Multiple Labels” on page 36
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Basic Operations
Creating a New Label

A

Start Label Editor.

B

Select the printer and tape you want to use.

The New/Open window is displayed. You can also open the window by clicking

Click

to update the tape settings to detected type and width of tape installed in the printer.

Note:
If the tape settings are not updated by clicking
menu.

C

.

, select the tape installed in the printer from the pull-down

Select a label type you want to create.
For example, select [1] Horizontal Text.
Note:
Label types that are not available with the set tape are grayed out and not selectable.
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[1]

[6]

[2]

[5]

[3]

[4]

1.

Lets you create a horizontal writing label.

2.

Lets you create a vertical writing label.

3.

U “Creating Labels for Equipment Tagging (Equipment Management)” on page 21

4.

U “Creating Cable Labels” on page 26

5.

U “Creating Labels Using an Excel or Other Format File” on page 24

6.

U “Creating Variable Length Labels in a Single Print (Mix-Length)” on page 18
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D

A template for the selected label type is displayed. Insert objects such as text and symbol.

E

Click

to print the file.

U “Printing Labels” on page 40
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Inserting Objects in a Label
You can insert multiple objects such as symbol, border, image, and barcode in a label, and arrange them freely. The
following procedure is an example to add a symbol after inserting a text.
Note:
Label Editor describes an inserted object as a “block“.

A

Click

in the tool box, and select a symbol you want to add in the Symbol window, then click OK.
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B

Insert the symbol by clicking at a position you want to insert it.

Note:
To align multiple objects at a time
Select all the objects, and align them using one of the Align options in the Layout menu.
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Changing Object Settings

A

Select an object you want to change the settings.
A settings window for the selected object is displayed.
Text settings window

B

Click

Symbol settings window

on the window to display the advanced settings window.
Symbol advanced settings window

Text advanced settings window

Note:
How to stop displaying the settings window
Select Settings - Preferences, and then change the display setting in the General tab. After you stop displaying the
settings window, you can open the advanced settings window in the following way.
❏

For text object
Select the text block and right-click on it, and then select Properties....

❏

For object other than text
Double-click on the object block, or right-click on it and select Properties....
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Selecting Printer and Tape
When creating a new label, select the printer and the tape in the New/Open window.
U “Creating a New Label” on page 4
The following explains the method using the tool bar.
[1]

[2]

1.

Click this icon to update the tape settings to detected type and width of tape installed in the printer. The
display of label in the Layout editing window is also updated. If the tape settings are not updated, select
the tape installed in the printer from Tape Width in the tape settings area.

2.

A list of available printers is displayed. Click

to display the printer driver window.
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Setting Label Length
By default, the label length automatically changes according to the objects inserted in the Layout editing window.
The following explains how to set the label length manually.

A

In the tape settings area, click on the tape length setting, and then select Manual.

B

Use one of the following methods to set the length.

❏ Enter a length in the Tape Length box.
❏ Drag the vertical line located below the right corner of the label.
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How to Use the Data Creation Window
The Data creation window allows you to create a large number of labels easily by importing a file created by Excel
or other application.
U “Creating Labels Using an Excel or Other Format File” on page 24
U “Importing a List of Equipment from an Excel File” on page 21
Note:
You can also enter data directly in the Data creation window without importing a file.

About Files to Import
Supported File Formats
xls, xlsx, csv, xlsm, txt

File Contents
❏ Enter data for a single label in one row.

❏ You do not need to delete unnecessary sheets, rows or columns in advance. You can select a sheet when
importing a file. You can select rows and columns after importing a file.
❏ Images such as photos
To import image files (BMP, JPG, TIF, or PNG) such as photos and illustrations, enter the full pathname of the
image file.
Example: C:\Users\Desktop\Images\aaa.png
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How to Operate the Data Creation Window
Editing Data
Double-click on a cell to edit or add data in the cell.

Sorting Data / Entering Column Title
Right-click on the data area to display menus for sorting data, entering column title, etc.

Changing Column Attribute
Click on

at the right of the column, and select attribute for the column from Column Attributes.

When a file is imported, attribute of the all columns is set to Text. You need to change the attribute for columns
that contain barcode or QR code data, or images (full pathnames of image files).

Selecting Rows to Print
You can select rows and print only the selected rows. Select the check boxes for the rows you want to print.

Note:
To print only the selected rows, a setting in the print dialog box is also required.
U “Printing Labels with Serialization Object or Labels Created Using the Data Creation Window (Advanced Settings)”
on page 41
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Exporting Data
You can export the data to a file by clicking Export.

Inserting Data into the Layout Editing Window
You can insert data from the Data creation window to the Layout editing window in one of the following ways.
❏ Drag the column
The shape of the mouse pointer changes to
displayed, you can drag the column.

when you move it over the column title. While
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❏ Use

in the tool box

When you click
, a dialog box as shown below is displayed. Select a column and click OK in the dialog
box, and then click at a position you want to insert it in the Layout editing window.

15

Label Editor

Online Manual
Basic Operations

Saving Label Files

A

Click

B

Save the file by specifying a location to save and the file name.

on the tool bar, or select Save from the File menu.

The file is saved under the specified name with ".leb" extension.
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Opening Saved Label Files
Note:
*

Label Editor version 2.0 or later does not support some functions that are available with versions earlier than 2.0. If you
are using version 2.0 or later and open a file created using the earlier version, the file may not be displayed correctly.
* Background Pattern, Text Art, Image trimming, and etc.

A

Select Open on the New/Open window or from the File menu.
[1]

[2]

B

1.

A list of recently used files is displayed. Preview of a selected file is displayed in the lower part of the window.
Double-click the file to open it.

2.

Allows you to specify a location and a file to open.

Select a file to open it.
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Creating a Variety of Labels
Creating Variable Length Labels in a Single Print
(Mix-Length)
You can create multiple labels with different texts, and print them at a time. Because the label length automatically
changes according to the text length, multiple labels with different lengths can be created easily and quickly.

Cable

A

Click

B

Click Mix-Length.

Do Not Connect

on the tool bar.
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C

Edit the first label.

D

Click

to display an edit window for the second label.

Note:
You can use the keys on your keyboard to move between multiple labels.
Tab key: lets you move to the next label
Shift key + Tab key: lets you move back to the previous label
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E

Edit the second label.

[1]

[4]

[2]
[3]

1.

Lets you delete the label.

2.

If your printer supports Data Transfer Tool, you can transfer the label file to the printer.
U “Transferring Label Files to Printer (Data Transfer Tool)” on page 38
U “Printers that support Data Transfer Tool ” on page 44

3.

Lets you change the text orientation.

4.

Lets you move to the next or the previous label.

Note:
❏ Up to 50 labels can be created in a single file.
❏

F

Click

Font type and size settings are applied to all the labels in the file.

to print the file.

All the labels in the file are printed.
U “Printing Labels” on page 40

20

Label Editor

Online Manual
Creating a Variety of Labels

Creating Labels for Equipment Tagging (Equipment
Management)
You can create labels for equipment tagging easily by using the templates.

Importing a List of Equipment from an Excel File
By importing your existing Excel file, you can create labels without entering data manually.
Note:
Because you can select a worksheet, columns and rows to use for labels, you do not need to change your Excel file to
match the template in advance.

A

Click

B

Click Equipment Management.

on the tool bar.
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C

Select a template you want to use, and then click OK.

D

Make the settings below, and then click OK.

❏ Select a tape width from Recommended Tape Width
❏ Select Data Importing (for Multiple Labels) and then select the Excel file to import.

E

Select which worksheet to import, and then click OK.
A label image with the data of the first row is displayed in the Layout editing window.
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F

Edit the label if needed.
Note:
❏ When inserting barcodes, change the attribute of the column that contains barcode data.
U “How to Operate the Data Creation Window” on page 13
❏

You can change font type and size settings for each block.
U “Changing Object Settings” on page 9

G

Click

to print the file.

U “Printing Labels with Serialization Object or Labels Created Using the Data Creation Window
(Advanced Settings)” on page 41

Entering Equipment Data Manually

A

Follow step 1 to 3 of "Importing a List of Equipment from an Excel File".

B

Select Data Entry, enter data, and then click OK.
Note:
When creating multiple labels, leave the entry fields blank and click OK. You can enter data easily in the Data
creation window.
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Creating Labels Using an Excel or Other Format File
You can create a large number of labels easily by importing your existing Excel, csv, or other format file.

A

Click

B

Click Import (Horizontal Text) or Import (Vertical Text).

C

Click Load Import Data. When a file selection dialog box is displayed, select and open a file you want to
import.

D

Click Overwrite Current Data.

on the tool bar.

If the first row of the file is used as a header row, select the check box for Use first row as column headers.
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E

Select which worksheet to import, and then click OK.

F

Insert the data from the Data creation window to the Layout editing window, and then format a label.

A blank label image is displayed in the Layout editing window, and the imported data is displayed in the
Data creation window.

To insert barcode or image data, change the column attribute before inserting it.
U “How to Operate the Data Creation Window” on page 13
Note:
You can change font type and size settings for each item.
U “Changing Object Settings” on page 9

G

Click

to print the file.

U “Printing Labels with Serialization Object or Labels Created Using the Data Creation Window
(Advanced Settings)” on page 41
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Creating Cable Labels
You can easily create various types of labels for wiring and cables.
The following explains how to create labels for Punch Block.

A

Click

B

Click Punch Block.

on the tool bar.

Note:
Label types that are not available with the set tape are grayed out and not selectable.
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C

Make the settings in the Parameter Settings area.

[6]
[1]
[2]
[3]
[4]
[5]

1.

Specify the number of serialized labels.

2.

U “Adding an Automatic Serialization Object in Labels” on page 32

3.

Displays the Data creation window.
If you have selected Blank/Data importing at [5], you can import a file in csv, xls, or xlsx format.
U “How to Use the Data Creation Window” on page 12

4.

If your printer supports Data Transfer Tool, you can transfer the label file to the printer. However, Self-Lam and
Heat Shrink Tube files cannot be transferred.
U “Transferring Label Files to Printer (Data Transfer Tool)” on page 38
U “Printers that support Data Transfer Tool ” on page 44

5.

Select Alphanumeric Sequence to set up automatic serialization. Select Blank/Data importing to enter pin
numbers manually, or to import data from an Excel or other format file.

6.

Lets you view the second and subsequent labels when you have specified more than one number of labels at
[1].

Note:
Font type and size settings are applied to all the labels in the file.
U “Changing Object Settings” on page 9

D

Click

to print the file.

U “Printing Labels” on page 40
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Printing Labels in Label Catalog
You can print labels contained in Label Catalog. A various types of label designs are available, such as caution
labels, warning labels, labels that can be used in an office, school, or hospital.
The label designs are editable, so you can also customize the labels.

A

Click

B

Click Label Catalog.

on the tool bar.
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C

Select a label in the Label Catalog window.

[1]

[2]

[3]

1.

Displays labels you have registered as Favorites.

2.

Select a tape width. Only labels available with the selected tape width are displayed.

3.

Lets you register or unregister the currently selected label as Favorites.

4.

Click this to customize the selected label.
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Printing the Same Text Repeatedly
By printing the same message repeatedly on a ribbon, you can create your original ribbon.
To create a ribbon, prepare a ribbon tape cartridge.

A

Enter a text.

B

Change font type, style, or other settings as you like.
Note:
❏ The font and other settings are applied to all the repeated texts.
U “Changing Object Settings” on page 9
❏

You can also add a symbol or an image.
U “Inserting Objects in a Label” on page 7

C

Click

on the tool bar.
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D

Enter required values, and then click OK.

E

Click

to print the file.

U “Printing Labels” on page 40

31

Label Editor

Online Manual
Creating a Variety of Labels

Adding an Automatic Serialization Object in Labels
You can create multiple labels with a series of numbers or alphanumeric codes. Only by setting the starting value
for the series and specifying the number of copies, you can print serialized labels.
Example:

A-001

B-002

C-003 .....

A

Click

B

Make the automatic serialization settings.

on the tool box.

The setting window is displayed.

[1]
[4]

[2]

[3]

1.

Set the starting value and change the increment setting if needed.
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2.

Click this to make the advanced settings. To create the example labels, change the settings in the A/S 3 column
as shown below.

3.

The result of your settings is shown here. Check whether the result is shown as intended.

4.

Lets you add an element of starting value.

Note:
To delete a column
Move the mouse pointer over the header of the column you want to delete, and click

C

.

Click at a position you want to insert the automatic serialization object.
The object is inserted with the

icon.

Note:
You can select the object block and change font settings.
U “Changing Object Settings” on page 9

To print serialized labels
Specify the number of serialized labels (number of copies) in the print dialog box.
U “Printing Labels with Serialization Object or Labels Created Using the Data Creation Window (Advanced
Settings)” on page 41
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Adding a Barcode or QR Code
A various types of barcodes and QR codes can be added in labels. You can also create a series of barcodes or QR
codes.

A

Click

or

on the tool box.

Note:
When you click either one of the icons, a setting window for the type of barcode or QR code you previously selected
is displayed. Click beside the icons to select another type of barcode or QR code.

B

Make the settings, and then click OK.

To create a series of barcodes or QR codes
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In the Alphanumeric Sequence window, specify a range in the code to be serialized and set the start value
and other settings.

U “Adding an Automatic Serialization Object in Labels” on page 32

C

Click at a position you want to insert the barcode or QR code.
The barcode or QR code is inserted in the Layout editing window.
Note:
You can select the block and change the barcode or QR code settings.
U “Changing Object Settings” on page 9
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Creating a Large Label by Printing One Image on
Multiple Labels
You can divide one label image into specified number of pieces and print them. By pasting the printed pieces of the
label together, a large label can be created.
Example:

Note:
❏ Each piece of the label is printed with top and bottom margins. Cut off the margins before pasting the pieces together.
❏

If your printer supports borderless printing, you can print the label pieces without the margins.
U “Borderless Printing” on page 40
U “Printers that support Borderless Printing” on page 44

A

Specify the number of pieces of a label in Print-Paste Printing.

B

Enter a text.

Dotted lines are displayed as the dividing lines.
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C

Format the label by adjusting position of blocks, font size, etc.

D

Click

U “Changing Object Settings” on page 9
to print the file.

You can print all pieces or select which piece to print.
U “Printing Labels created using the Print-Paste Printing Function (Advanced Settings)” on page 42
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Transferring Label Files to Printer (Data Transfer Tool)
If your printer supports Data Transfer Tool, you can transfer the following files to the printer.
❏ Cable label file (created by the following functions; Punch Block, Block-66, Patch Panel, Faceplate, Flag, or
Wrap)
❏ Label file created by the Mix-Length function
❏ Image file (BMP, JPG, PNG)
U “Printers that support Data Transfer Tool ” on page 44
The transferred file is stored in the printer‘s memory. You can print the label directly from the printer without using
a computer.
Note:
A minor adjustment of the transferred file may be needed on the printer. Check the file using the preview function of the
printer before printing it.

The following explains how to transfer a cable label file (U “Creating Cable Labels” on page 26).
For instructions on how to open the transferred file, see the printer manual.

A

Select Transfer Data, and then click the Transfer button.
Data Transfer Tool is started.
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B

Select Transfer Files, and then click the Transfer button.

[1]
[2]
[3]

1.

Select this to transfer a single file.

2.

Select this to transfer more than one files (file extension is .dt3) that were saved using Data Transfer Tool.

3.

If your printer supports image transfer function, you can transfer image files in BMP, JPEG, or PNG format to the
printer. Click the Load button and select an image file to transfer.
Printers that support the image transfer function U “Printers that support Data Transfer Tool ” on page 44

Note:
To save the file under a new file name on the computer, click the Save button. The file is saved in transferable
format (file extension is .dt3).
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Printing
Printing Labels

A

Click

B

Make the print settings, and then click Print.

on the right side of the window.

Printing is started.

[2]

[3]

[1]

1.

Specify the number of copies.

2.

Click this to display the printer driver properties window. You can change the tape settings, cut settings, etc.

3.

Click this to make the settings for serialized labels, or labels created using the Data creation window or using
the Print-Paste Printing function.

Borderless Printing
If your printer supports borderless printing, you can print labels without top, bottom, left and right margins.
U “Printers that support Borderless Printing” on page 44

A

In the tape settings area, click the Margins setting, and select the Borderless Printing check box.
All margins disappears from the label image in the Layout editing window, and entire print area is used as
the label area.
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Printing Labels with Serialization Object or Labels Created Using
the Data Creation Window (Advanced Settings)
On the Print dialog box, click Advanced Settings and make the necessary settings.

[1]

[2]

[3]
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1.

Select this check box to print labels with automatic serialization object.

2.

Select this check box to print multiple labels created using the Data creation window.

3.

If you have selected rows to print in the Data creation window, select this check box.
U “How to Use the Data Creation Window” on page 12

Printing Labels created using the Print-Paste Printing Function
(Advanced Settings)
You can select one or more pieces of the divided label, and print only the selected pieces. Scroll to the bottom of the
Advanced Settings window, and make the settings in Print-Paste Printing.

[1]

[2]

1.

Select this check box to enable selection of pieces of the label to print. Clear this check box to print the all
pieces.

2.

Click on a piece you want to print.
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Changing Preference Settings
Changing Preference Settings (Preferences)
The preference settings allow you to display or hide some windows, and change default settings of display, font,
shapes, and print settings.
From the menu bar, select Settings - Preferences.
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List of Printers by Supported Function
Printers that support Data Transfer Tool
Available Function
Model Name
File Transfer

Image Transfer

LW-Z5010 Series

✔

✔

LW-Z900

✔

-

LW-Z700

✔

✔

LW-PX900

✔

-

LW-PX750

-

✔

LW-PX700

✔

✔

LW-K600

-

✔

Printers that support Borderless Printing
❏ Pro100
❏ PEARLabel 400iXL
*The function is available with 50 or 100 mm width tape.
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H_DEF.FM
Conv Info.

A
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B

M00124801

C

EN

D

STD

E

STD

F

NA
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